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Tweaking Windows' Taskbar 
By Gabe Goldberg,  

APCUG Advisor; Columnist,  
AARP Computer & Technology Website,  

www.aarp.org 
 
 It's easy to use a key part of Windows' screen real estate, the taskbar, without really no-
ticing it. Like a car's dashboard, taskbar components summarize what's happening on 
your computer and access running software. But unlike your car's dashboard, the taskbar 
can be customized for individual needs and preferences. 
 www.aarp.org/learntech/computers/howto/tweaking_windows_taskbar.html 

 Fun with Windows' Taskbar 
 I've read reports that most people can't accurately draw their car's dashboard, no matter 
how many hours or years they've stared at it. Similarly, many of us look at and use a key 
part of Windows' screen real estate -- the taskbar -- without paying much attention to it. 

 Like a car's dashboard, taskbar components -- Start button at one end, notification area 
icons at the other, and application buttons in between -- summarize what's happening on 
your PC and give quick access to running software. But the taskbar is more interesting 
than a car dashboard: you can customize it for your individual needs and preferences. 

 This article describes Windows XP's taskbar; other Windows versions have mostly simi-
lar facilities. People sometimes worry when their taskbar disappears or suddenly looks 

(Continued on page 2) 

SEPTEMBER PROGRAM 
Our speaker for September will be Mr. Chris Schultz with Voodoo Ventures. Voodoo Ven-
tures is a business incubator with different ideas about what it means to be a company, not to 
mention a technology company in New Orleans. Mr. Schultz will discuss Web 2.0, Hucka-
buck.com, and other company projects.  

Chris Schultz is an entrepreneur who is driven by thinking about what’s next. In 2001 he 
launched an Internet travel service offering destination management services in Las Vegas, 
New Orleans, Miami and Reykjavik, Iceland. Following the acquisition in 2005 of that com-
pany, Destination VIP, he shifted his focus to Voodoo Ventures which is dedicated to emerg-
ing technologies on the Web. 

Chris founded Voodoo Ventures in New Orleans, and for the past four years he has continued 
to grow his company by leveraging emerging technology trends and incubating simple, scal-
able business ideas.  Currently the company is incubating several projects including a search 
engine, and outsourcing firm and a Web application that powers marketing Web sites. 

Mark your calendars, create an entry in your PDA, modify your Yahoo calendar, update Out-
look and join us on Wednesday, September 6, 2006. The monthly meeting of the NOPC club 
starts at 6:30pm on the first Wednesday of every month.  Location of the meeting is the J.D. 
Meisler school cafeteria at 3700 Cleary Ave.Metairie.  Use the entrance through the breeze-
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odd -- or moves to an unfamiliar place on the screen. We'll 
see how such glitches are easily fixed. 
 Right-clicking a blank taskbar area displays Windows' fa-
miliar context menu, showing available options. Clicking 
Toolbars lets you display or hide built-in toolbars (groups 
of icons representing programs, folders, or files) or create 
your own. My favorite toolbars are Desktop (a handy pop-
up list which duplicates desktop icons) and Quick Launch 
(which holds the few key icons I always want immediately 
available). Other standard toolbars are Address and Links.  

 Cascade and Tile options specify arrangement of open 
application windows: fanned like playing cards or arranged 
in a grid.  

 A key option -- Lock the Taskbar -- controls whether you 
can change the taskbar. When the taskbar is unlocked, you 
can change its size by dragging its edge away from or to-
wards the screen's edge. You can move individual toolbars 
by grabbing their handles (perforated line near each one) 
and move the taskbar by grabbing a blank area. 

 Clicking Properties brings up a detailed options dialogue 
box. It's safe to experiment but only change one thing at a 
time until you learn your way through all the choices. 

 The Taskbar tab customizes the taskbar itself and its noti-
fication area. You can auto-hide the taskbar -- handy on 
small monitors to reclaim space for application windows. 
When it hides, moving the mouse near it makes it visible. 
You can always keep the taskbar on top of other applica-
tions, or allow it to be covered. If it's hidden, pressing ctrl-
esc displays it. 

 Similar task bar buttons -- for example, representing multi-
ple Word documents -- can be grouped to save taskbar 
space, or spread out. If they're grouped, left-clicking the 
group displays all open files, and right-clicking lets you ma-
nipulate the files simultaneously. 

 You can add and delete Quick Launch toolbar icons by 
dragging them on or off the toolbar. I trimmed mine to 
two icons: Show Desktop and Windows Explorer. From a 
Windows keyboard, these are available by pressing Win-D 
and Win-E, respectively. 

 The notification area (called the "tray" in earlier Windows 
versions) shows icons for small applications or utilities that 
are running, plus your clock. Mousing over an icon pops 
up its name. You can control which icons are displayed and 
whether inactive icons (representing programs you haven't 
used for a while) are hidden. Each program running con-
sumes PC resources so it's worth monitoring these icons 
and pruning any which aren't necessary. Right-click an icon 
to display options. Closing some applications prevents 
them from automatically starting at system boot, while oth-
ers offer an explicit option. 

 Continuing our tour through taskbar properties, the Start 
Menu tab lets you specify Start Menu appearance and op-
eration. You can pick large or small icons and determine 
how many shortcuts are saved in it for recently used pro-
grams. Key programs can be "pinned" to the Start menu by 
right-clicking a desktop icon or dragging an icon to the 
Start button and placing it in the permanent top area. The 
Advanced tab determines Start menu behavior and lets you 
select modern or "classic" Start menu format. 

 Finally, when the Taskbar is unlocked, three extra toolbar 
right-click options are available: View, Show text, and 
Show title, for fine tuning your PC's "dashboard". 

 While Windows operates just fine as it's installed, tweaking 
taskbar settings and other options can make it faster and 
more pleasant to use. And since there are usually multiple 
ways to accomplish tasks in Windows, it's worth exploring 
-- for example, right-clicking to explore context menus and 
clicking various options/customize/advanced buttons to 
see what's available. Don't be afraid to tinker, but remem-
ber what you change so you can undo it! 

 This article originated on AARP's Computers and Tech-
nology Web site, www.aarp.org/computers, and is copy-
righted by AARP. All rights are reserved; it may be repro-
duced, downloaded, disseminated, or transferred, for single 
use, or by nonprofit organizations for educational pur-
poses, with attribution to AARP. It should be unchanged 
and this paragraph included. Please e-mail Gabe Goldberg 
at gabe@gabegold.com when you use it, or for permission 
to excerpt or condense. 
 
How to know what’s in a file or folder 

before you open it 
by Linda Gonse, Editor, Nibbles & Bytes, Orange County 

IBM PC Users’ Group, California 

Sometimes you just don’t know what’s in a file by the 
title alone. You may have created it so long ago, you’ve 
forgotten. Or, you received a file from someone who gave 
it a cryptic name. Most of the time, if you are like me, you 
bite the bullet and open the darned thing. This means wait-
ing for an application to load before the file opens. If your 
attention doesn’t wander, you’ll spend exasperating sec-
onds — maybe even a minute or more — drumming impa-
tiently on the desk. Otherwise, you get distracted looking 
through papers or books in your To Read stack, and jerk to 
awareness 10 minutes after the file has opened. 

 
Either way, you don’t get the information you need 

when you want it. 
 
Call it secret, or just overlooked information, but there 

(Continued from page 1) 

(Continued on page 3) 
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are ways to glimpse file information so you don’t have to 
open the files or folders to see what they contain. 

 
FILES — Stay with me while I open my ORCOPUG 

folder in the Details view and click on a subfolder titled Ira 
Wilsker. There’s a list of files in the right window pane that 
I have saved Ira Wilsker’s emails. But, now I’m not sure 
what they contain. So, I go to View on the menu bar and 
check to be sure that Status Bar has a check next to it. 
Next, I click on the file titled “ATT00010.doc.” 

 
 

 
 
To add the Status Bar to your folders, you have to select it 
under View. 
 
 

 
 
Information about a file shows up in the Status Bar at the 
bottom of an open folder. 

 
 
The author of the file, the actual title of the file, the 

date it was created and the size of the file all appear at the 
bottom of the pane in the status bar.  

 
 

 
 
Hover your cursor over a file for a popup box with the file 
information in it. 

 
Or, I could just hover the mouse over the file name for 

a second or two and a popup will show me the file infor-
mation. If you don’t see a popup when you hover your 
mouse over a file, in an open folder go to Tools > Folder 
Options > View. Then, scroll almost to the bottom of the 
list and check the box next to “Show pop-up description for 
folder and desktop items.” 

 
The third option for checking on file innards is to right 

click on the file name, and go to Properties in the drop 
down list. Left click on Properties and go to the Summary 
tab. The author’s name and the title of the document will 
be there. 
 

 
 
The Properties box defaults to author and title. Other in-
formation can be added to this file, also,  at the time the 
document is created or modified. 

 
 
FOLDERS—You can make searching through folders 

easier (and even more fun) by using a custom picture to 
remind you of the contents. Or, you could assign a custom 
icon for the folder so it will stand out from the rest of the 
folders. 

 
Go to the settings under the View menu in an open 

folder. First select Thumbnails. Then, go back into the list 
and click on Customize this Folder 

Click on the Customize tab and then the “Choose Pic-
ture” button. Find a picture in the folder (or in any other 
folder) that will remind you of what types of files are in this 
folder. For example, my folders are filled with articles for 

(Continued from page 2) 

(Continued on page 4) 
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the newsletter from various writers. One folder contains 
articles by Ira Wilsker and images for his articles, so it 
makes sense to put Ira’s photo on the folder. I browse to 
his picture, select it, click Open, then click Apply and OK. 

 
Take a look at the folder now (below) in Thumbnail 

view. There’s no way you can miss this folder, or forget 
what is inside of it! 

 
 
 
In other views, such as Icon view, you won’t be able to 

see a picture on the folder. But, you can still make the 
folder stand out from the rest. Or, if you have a group of 
folders that are similar, you can change all the folder icons 
so they will stand out as a group and be easier to locate. 

 

 
 
 
To change a folder’s icon, go back to View and Cus-

tomize This Folder. At the botton of the dialog box, click 
on the Change Icon button, and select an icon. Click Apply 
and OK, and go take a look at the folders in icon view. 

 
 

 

 
 
 
 It’s hard to miss the special icon, isn’t it?  
 
 

 
 
 

Try it yourself and discover how easy it can be to identify 
the folders you need, instantly and without guesswork. 

The Editorial Committee of the Association of Personal Computer 
User Groups (APCUG), an international organization of which this 

group is a member, brings this article to you. 
 

Choose Your Own “Home Page” 
By Ira Wilsker 

 
 WEBSITES: 
http://my.yahoo.com 
http://www.live.com 
http://www.msn.com 
http://www.theexaminer.com 
http://www.mozilla.com 
http://my.netscape.com 
http://www.google.com/ig?hl=en 
 
 I work on a lot of different computers at a variety of loca-
tions, and one factor that consistently astounds me is that 
many people have blissfully ignorantly never changed their 
startup “home page” from its default.  This is the page that 
first opens when the user connects to the internet.  For 
example, many Dell computers have the Dell website set 
for the startup page when the user first accesses the inter-
net, while Windows itself, unless otherwise changed, de-
faults to Microsoft’s MSN home page, making it one of the 
mostly used startup pages.  Many internet service providers 
(ISP), such as AOL, AT&T, and others changed the users’ 

(Continued from page 3) 

(Continued on page 5) 
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home page to the ISP’s selected home page. 
 
 Startup or “home” pages are big business because they are 
commonly advertiser supported, and the more views (also 
referred to in the industry as “hits”), the more revenue 
generated by the host.  This on-screen real estate is so valu-
able that a type of malware or spyware, sometimes known 
as homepage hijackers, will attempt to change your home-
page to its client’s home page, for which the miscreant re-
ceives compensation for each page such changed. 
 
 There are many different services offering home pages, 
and if the user finds one that he likes, it is very easy to 
make the selected page the new home page.  The process 
for selecting the default home page is the same for most 
browsers.  Using Microsoft’s Internet Explorer (IE), which 
is still the most widely used browser in the world, the proc-
ess is simple.  If the user visits a website that he would like 
as his homepage, he simply clicks on “Tools” on the menu 
bar, and then that will open a window where the home 
page can be selected.  If the open page is what is desired, 
then click on the “Use Current” radio button, and the cur-
rent page will be displayed each time the browser is loaded.  
If “Use Default” is selected, the home page will revert back 
to the Microsoft (or other manufacturer) default start up 
page.  On the new Internet Explorer 7 (Beta), which offers 
tabbed browsing, a different home or startup page can be 
selected for each tab.  For those who do not want to con-
nect to any page at all when loading the browser, IE7Beta 
offers the option of a blank page.  All versions of IE also 
allow for the manual entering of any selected internet ad-
dress for a home page.  To directly go back to the home 
page at any time, simply click on the little house or “home” 
icon on the menu bar. 
 
 Firefox (www.mozilla.com), one of the most popular 
browsers behind IE, offers a simple interface to select or 
change the homepage.  Clicking on “Tools” on the menu 
bar opens a window where “General” can be selected, and 
then “Home Page”.  Firefox allows the address to be 
manually entered, or the current page loaded can be se-
lected.  Other options allow for the home page to be se-
lected from a previously saved bookmark (Internet Ex-
plorer calls these “Favorites”), or the option for a blank 
startup page can be selected.  Firefox also offers the little 
house on the menu bar for instant access to the home 
page. 
 
 There are many choices for a home page, which is totally 
up to the user.  Some users use their web mail accounts as 
a home page, first displaying their email when connecting 
to the internet, while others may choose retailers, auction 
sites, employer web pages, search engines (such as Google 
or Yahoo), newspapers (such as the Examiner at 

www.theexaminer.com), or any other page of interest.  
While any page can be selected as a home page, the most 
popular home pages selected are usually news and informa-
tion based pages. 
 
 My personal favorite, which I use on all of my computers, 
is “My Yahoo”, at my.yahoo.com.  I have found My Yahoo 
to be the most comprehensive and flexible home page.  
Being an information junkie, I have customized my My 
Yahoo page to include stock and mutual fund listings, 
news from dozens of sources, weather, lottery results, 
sports scores, my personal calendar, latest emails received, 
TV listings, and other information.  My Yahoo, which is 
very easy to configure, directly offers thousands of choices.  
Many information resources, such as the Examiner, are 
now using “RSS” or “XML” feeds as a news source, and 
these can be added to My Yahoo often with a single mouse 
click.  My Yahoo is also customizable with hundreds of 
backgrounds, color schemes, layouts, or other features to 
personalize it. 
 
 Microsoft is currently testing a new homepage intended to 
at first supplement its flagship homepage at 
www.msn.com, and maybe later replace it.  This new 
homepage, currently in beta testing, is currently online at 
www.live.com.  It will be a strong competitor to My Ya-
hoo, offering news, sports, weather, email, and other re-
sources in columns that are infinitely customizable. 
 
 There are countless other “My” homepages available, such 
as AOL’s my.netscape.com, and other personalized home 
pages, including Google’s “Personalized Home” link sitting 
quietly on the top right corner of the popular google.com 
website.  All of these home pages can be easily customized 
to suit individual needs. 
 
 There is no need to continue to use the default startup or 
home page provided by your operating system or ISP.  In-
vestigate some of the alternatives, and increase your enjoy-
ment of the web. 
 

antivirus Company Warns About 
Firefox Add-Ons 

Reports indicate that the Mozilla Firefox browser, an 
alternative to Microsoft's Internet Explorer, is used by 
12 to 15 percent of people in the U.S. 
Many choose it because it is presumed to have fewer 
security flaws than IE, or because it offers what are 
called extensions, add-ons that can do many things, 
including put weather or music-player controls in a 
browser window or add new ways to search without 
going to a new site. 

(Continued from page 4) 

(Continued on page 6) 



 But antivirus firm Symantec warns that those exten-
sions could be used by hackers to steal personal in-
formation. 
 The company said that it has located an extension 
that tries to steal personal information. It monitors 
all forms submitted online, taking the information 
and sending it to a remote person. That information 
could include Social Security numbers, credit card 
numbers or passwords. 
Unlike some security threats in IE, the extension can 
only go to work if a user chooses to install it. They 
could be duped into doing so by going to an untrust-
worthy site or by loading a program that hides the ma-
licious code. 
 Alfred Huger, senior director of engineering Symantec, 
said that antivirus software should catch any malicious 
extensions before they are installed, if the files are 
scanned. 
 He also said that there have been fewer than 50 re-
ports of dangerous extensions installed, but there was 
data stolen. 
 Extensions should only be installed from trusted 
sources -- including Mozilla.com. 

Borrowed from WDSU.COM, 
Posted July 27, 2006. 

 
Virus protection 

Remember: Don’t open e-mail attachments that end 
in .vbs, .pif or other unfamiliar extensions. Even if 
the e-mail appears to come from a trusted source, it 
could be someone “spoofing” an address. Confirm it’s 
from who you think it’s from before you open. 
 

Daffynitions 
A lawyer is a person who writes a 10,000-word document 
and calls it a "brief." (Franz Kafka) 

A psychologist is a man who watches everyone else when a 
beautiful girl enters the room. 

A programmer is someone who solves a problem you did-
n't know you had in a way you don't understand. 
 

DILBERTISMS 
"E-mail is not to be used to pass on information or data. It 
should be used only for company business."  (Accounting 
manager, Electric Boat Company) 

"Doing it right is no excuse for not meeting the schedule."  
(Plant Manager, Delco Corporation) 

"This project is so important we can't let things that are 
more important interfere with it."  (Advertising/Marketing 
manager, United Parcel Service) 

Pick up Your E-mail From Any 
Computer, Anywhere in the 

World 
Sue Crane, Big Bear Computer Club, CA 

Sue.crane@charter.net 
Your e-mail messages are held on the server of the com-
pany you’ve contracted with for Internet service until you 
log in and pick up your messages. You can pick up your e-
mail messages when you are away from home, too. 
Many Internet Service Providers have a link on their web 
page that allows you to pickup your Mail from any com-
puter that is connected to the Internet. You can also use a 
service called Mail2web.com. 
Simply go to their web site and log in with your e-mail ad-
dress and password and you will see all e-mail messages 
you have not retrieved. If you want to save the messages, 
do not delete them from the server. 

Monitor What The Kids View 
Adult Photo Blanker guards computer users from the ubiq-
uitous expansion of pornography and violence in our life. 
This program not only prevents your children from access-
ing unwanted websites, but also controls the content of 
video files and photos loaded into your computer memory 
from the hard disk. This smart tool monitors nearly all 
multimedia content.  
Adult Photo Blanker uses 11 special criteria to reveal ob-
jectionable films, websites, images and the like. The pro-
gram combines this built-in artificial intelligence scanner 
with the keyword filter, which recognizes unwanted con-
tent by specified words, and it is concealed from inexperi-
enced users. Adult Photo Blanker is protected with a pass-
word, so if you want to turn it off and watch an adult film, 
you must use the password you previously specified.  
It features Block and Safe lists to customize each user set-
tings individually. Each family member can configure op-
tions of the program in his/her own way. By the time you 
read this, a newer version will be introduced. 
Adult Photo Blanker runs under Windows 98  / ME 
(partially) / 2000 / XP and costs $49.95 (USD).  
Users group members receive a 20% discount.. 
Just enter DEAL-LSFQ-GUY where it calls for a 
coupon when downloading the paid version.  
A fully functional trial version of the program is available 
as a free download at <http://www.oreware.com/ 
download_prog.php?id_prog=25>  File size:(4.09 Mb) 
Product page URL:  
<http://www.oreware.com/viewprogram.php?prog=25> 
Web Page: <http://www.oreware.com> 

Space Coast PC Journal September 2006 
“From the Deals Guy” 

(Continued from page 5) 
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THE SECRET GUIDE  
TO COMPUTERS 

The Secret Guide is available at every New 
Orleans Personal Computer Club General 
Meeting. The latest printing is available  for 
only $15.00. Or contact Tom Ford either at: 
secretary@nopc.org or (985) 643-3172. 



The New Orleans Personal Computer Club (NOPCC) is a private non-profit organization chartered under the State of Louisiana. Its purpose is to  provide an open forum for discussion 
and education of the membership in the use and application of PCs,  peripheral equipment and software. The opinions expressed in this newsletter are those of the author (s) and do not 
necessarily reflect those of the NOPCC , its members or its officers. The club does not verify for accuracy the articles in this newsletter and leaves verification of accuracy to its readers. 
Articles in this newsletter may be duplicated as long as credit is given to the author (s) and the NOPCC. Annual Dues Schedule: Regular Member, $40/yr.; Family Membership, $60/yr.; 

SUN MON TUE WED THU FRI SAT 
     1 2  Living with  

Home Electronics  
WIST 690AM  
10a-11a 

3 4 5 6 NOPC Gen Mtg 
J.D. Meisler School 
6:30p-8:30p 

7 8 9  Living with  
Home Electronics  
WIST 690AM  
10a-11a 

10 11 12 13 NOPC BOD 
    @ McCann’s 
    6:30p-8:30p 

14 15 16 Living with  
Home Electronics  
WIST 690AM  
10a-11a 

17 18 19 Genealogy SIG 
7:00 pm  Call 887.5746 
for meeting location 

20 21 New User SIG 
Old Metairie  

Library 
6:30p-8:30p 

22 23 Living with  
Home Electronics  
WIST 690AM  
10a-11a 

24 25 26 27 28 29 30 Living with  
Home Electronics  
WIST 690AM  
10a-11a 

September 2006 

NOPCC Directory 
Elected Officers 

President   Ashton C. Mouton, Jr. president@nopc.org   246-7759 
Vice President   Ray Paternostro . vp@nopc.org    737-9099 
Secretary   Tom Ford  secretary@nopc.org         985-643-3172 
Treasurer   Don Herrmann  treasurer@nopc.org   831-1284 
Director At Large   Carl Henderson  director1@nopc.org   466-3954 
Director At Large   Mary Prinz  director2@nopc.org    455-1412 
Director At Large   Mike York  director3@nopc.org          

Standing Committees 
BBS SysOp   Lanny Goldfinch  sysop@nopc.org    482-5066 
Newsletter Editor   Edward Jahncke  editor@nopc.org          985-892-4797 
Public Relations   Jeannie Okamoto  pr@nopc.org    455-0977 
Publicity   Jeannie Okamoto  pr@nopc.org    455-0977 
Webmaster   Sherrie Henne  webmaster@nopc.org         504-913-5638 

Special Interest Groups 
Computer Programming  Elliot Mike York  mike@gnonug.org   738-5997   
Digital Media   Ray Paternostro  dm@nopc.org    737-9099 
Genealogy   Vincent Haupt  hauptv@aol.com          985-785-6288 
Internet    Ray Paternostro  internet-m@nopc.org   737-9099 
New Users   Tom Ford  new-user@nopc.org         985-643-3172 
Web Lab   Edward Jahncke  editor@nopc.org           985-892-4797 

Other Important Numbers / Addresses 
Club Hotline  Recorded messages. Meeting Information. Open 24 Hours    887-5746 
NOPCC Web Site On the World Wide Web. Our own home page and club information.        www.nopc.org 


